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Getting Started
PRIMER PREMIER is an application ready to assist you in designing
the best primers for your research needs. With its advanced features
primer search, primer database, multiplex/nested primer design,
primer editing and analysis, optimal primers can be designed to get
higher efficiency amplifications. Designing primers for long PCR of
sequences up to 50 kb is possible. It consists of four main functions:

GeneTank
Primer
Align
Enzyme
Motif

What's New in this Version
Cross species primers - designs primers for amplifying
sequences from multiple species
Pathogenic detection primers - designs primers in highly
conserved regions
Allele specific primers - design primers that will exclusively
amplify a single member of a set of related sequences

Navigational Basics
The navigation through PRIMER PREMIER is designed to be
intuitive... not much needs to be said about it. Just a few points
regarding menus and list boxes will suffice:

Each of the four main functions, GeneTank, Primer, Enzyme and
Motif has its own specific menus, which are accessible only through
windows within the function. The active window determines what
menus you see.  Here is a list of  the main functions with their main
functions:

GeneTank: File, Edit, View, Search, Function, Translate, Window,
Help.
Primer: File, Edit, Function, Report, Graph, Window, Help.
Enzyme: File, Function, Window, Help.
Motif: File, Function, Window, Help.
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Using the function menu you can activate the main windows of each
function. The window menu keeps track of all open windows and can
be used to change the active window.

Most list boxes have multi-selection facilities. Holding CTRL key for
Windows and Power Mac while clicking adds to the selection list.
Holding SHIFT key down while clicking selects a range, everything
between the last selection and the new SHIFT-click.
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GeneTank
With the GeneTank function you can load DNA or Protein sequences.
You can translate and back-translate in different frames. The
standard codon table and several mitochondrial tables are provided
for your convenience. You can also input additional mitochondrial
codon tables if you wish. The sequence editor provides complete
sequence editing capabilities including multi-media voice readback.

The function has the following sections:

GeneTank Window to load, view, edit and translate the sequence.
Translation to translate loaded sequence into other type and back.
Edit Codon Table Window to edit codon table for translation.

GeneTank Window
The main GeneTank window helps you view the sequence and its
header information. The sequence can be viewed in 3 or 10 base
groups. You can translate a loaded sequence into another type and
back. You can edit the sequence you are working on, using  standard
Cut, Copy and Paste. It provides access to the Primer, Align, Enzyme
and Motif functions.

Viewing the Sequence
You can access the header, 5’ end sequence number and group into
3 or 10 base groups by clicking the buttons or using the View menu.
The header is the text upstream of the first line of nucleotides. Display
the header by clicking on the header button or selecting it from the
menu. If you change the 5' sequence number, the numbering of
whole sequence gets updated starting from the number you have
given to the 5' end.

Alternate Access:
View > Show Header
View > Grouping
View > 5’ Seq No

Open Sequence Menu
This is where you load sequences you want to work on. You can
choose the file containing the desired sequence by using the file
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selection dialog.

Note for Windows: The default selection assumes that you store your DNA
sequences with SEQ suffix and protein sequences with PRO suffix. Of
course, you may use any convention you wish.

If the sequence is in standard GenBank format PRIMER PREMIER
recognizes the start of the sequence and loads it. Or if you have
saved the sequence previously using PRIMER PREMIER File > Save
menu, the sequence is  in PRIMER PREMIER format and is loaded
automatically.

Otherwise, the Import Sequence window opens with the entire
sequence visible in the scrolling box. Double click on first line of
nucleotides where the sequence begins. Everything above this line is
the "header". PRIMER PREMIER filters out illegal characters and
loads the sequence in the GeneTank window. Double clicking the
first line of nucleotides closes the Import Sequence window and
returns you to the GeneTank window with the sequence loaded.

Insider Info: If the file you chose is wrong and does not contain the
sequence you wish to load, simply close the Import Sequence window and
start all over.

New Sequence Menu
This function is intended primarily for you to type in a sequence that
you want to enter manually.

You can type in any sequence i.e., DNA or Protein and save it in your
favorite directory. Once the sequence is entered you can perform all
of the functions on it as if it was loaded from GenBank or any other
format.

Saving the Sequence
If you save the sequence, you can reopen it easily as PRIMER
PREMIER loads it correctly without asking you to identify the first line
of nucleotides with a double click. You should save the sequence if:

You want to revisit the same sequence frequently and want to
be able to load it quickly.
You have edited a sequence and want to save the results.
You have typed in a new sequence.
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Editing Sequence
Now you can edit DNA or protein sequences directly in the GeneTank
without going into any other window.  Editing original translated
sequences can be done effectively.   Changes in any one type are
reflected in the other, as it should be. For example, if you delete an
amino acid of a protein sequence (whether translated or original), the
corresponding codon will be deleted from the DNA sequence. If you
make a change in the translated sequences then the corresponding
changes are reflected only in the other translated sequences and not
in the original sequence. You can type in the sequence or import it
through the clipboard.

The usual cut, copy and paste functions are available to facilitate
editing. The keyboard short cuts are CTRL-X, CTRL-C and CTRL-V.

Grouping of 3 nucleotides is available to simplify working with
proteins.

When entering DNA you can use A, C, G, T or any of the common
ambiguous bases listed in Appendix B. When entering proteins you
can use the single letter abbreviation of the amino acids listed in
Appendix C.

To import a sequence through the clipboard, copy it onto the
clipboard using any editor such as Notepad and then paste it in. Save
the sequence after you finish editing.

Search
You can search for a particular pattern within the sequence starting
from the current position of the cursor, using the Find button on the
GeneTank Window. You can continue the search for the occurrence
of same pattern in the remaining document using Find Next button.
You can place the cursor at a particular position by selecting Go To
Position from the Search Menu.

Alternate Access:
Search > Find
Search > Find Next
Search > Go To Position

Viewing different strands
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To view the other strand of the loaded sequence i.e., anti-sense
strand, you just click on A button on the GeneTank Window and the
anti-sense strand will be displayed. To revert back to the original
strand click on the S button. You can also view both strands by
clicking on ds DNA button.

 Alternate Access:
View > Sense Strand
View > Anti-sense Strand
View > ds DNA

Voice readback
Once the sequence is loaded in the GeneTank, you can get voice

readback of sequence by pressing the  button. The sequence
will be read starting from the current position of the cursor. Pressing
the button again will terminate voice readback. To get voice readback

while typing in the sequence press the  button and then type.
Pressing the same button will terminate the process.

Alternate Access:
Function > Speaker

Editing an Alignment
After performing a multiple sequence alignment, the alignment results
can be edited to produce a more accurate match.   Usually, ClustalW
produces an accurate alignment so manual editing is not necessary.
But in case of difficult sequences or specialized research needs, the
ability to edit an alignment is provided.  Place the cursor where you
wish to edit by clicking on the base.  To insert a gap, press the space
bar.  To remove a gap press the delete key.  As the alignment is
edited the majority and minority consensus automatically update.
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Paste Sequence Window
This window enables an oligo to be pasted in four different ways.

The oligo can be pasted as it is by selecting As Is, reversed,
complemented, or reverse complemented.  This makes it easy to
paste in oligos from another program regardless of the sense or
direction in which it was stored.

Preferences Window
The Preferences window sets up the default values for various
parameters that are used in the product. It also allows you to access
the Rating Parameters window where weights for secondary
structures of primers, used in primer rating calculation can be set.

Default Primer Length - Default value = 25.
This value determines the length of the primer in the Direct Select
function of the Primer Premier Window. It also determines the length
of default primers when PRIMER PREMIER window is initially
launched. The default primer length can be set between 1 and 70
bases..

Maximum Number of Pairs Searched - Default value = 100.
When searching for primer pairs, the number of pairs found can be
very large. Since we search the pairs based on how good they are,
the primers that pass the search criteria, but are rated very low may
not be useful. Thus an arbitrary limit of 100 has been selected by
default. You can change it to any number between 10 and 1000.
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Nucleic acid concentration - Default value = 250 pM.
According to the formulation of Freier et al. (7), this is the total molar
concentration of the annealing oligos, when oligos are not self-
complementary. It is neither the primer concentration nor the initial
template concentration. It is based on the PCR product concentration.
Since the concentration of the template changes dramatically during
the course of PCR, it is difficult to define its value. It has been
empirically determined that setting its value to 250 pM, as suggested
by Rychlik, W. et al. (11), gives good results in a wide variety of PCR
and sequencing reactions. This value is used for calculating the
melting temperature of the primer.

Monovalent ion concentration - Default value = 50 mM.
This value determines the concentration of all the monovalent ions
present in the reaction mixture.

Free [Mg2+] ion concentration - Default value = 1.5 mM.
This value determines the concentration of Mg2+ ions, used as
binders, in a reaction mixture.

Total [Na+] equivalent -
This value is calculated using the value of Monovalent Ion
Concentration and Free [Mg2+] ion concentration. The formula for
calculating Total [Na+] equivalent is as follows:

Total [Na+] equivalent = Monovalent ion concentration + 4 * Sqrt (Free
[Mg2+] ion concentration * 1000)

This value is used for calculating melting temperature of primer.

Temperature for Free Energy Calculation - Default value  = 25 °C.
This is the value of temperature that will be used to calculate the ∆G
values. ∆G is calculated using the formula ∆G=∆H - T * ∆S.

Rating Parameters
Rating parameters window is used to set weights for secondary
structures to obtain primer rating. The more stable are the secondary
structures, the lesser will be the rating. If the secondary structure is a
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3' end secondary structure, it reduces the PCR amplification
efficiency more than the one that occurs internally. To take that into
account we subtract 1 from the ∆G value of the 3' end secondary
structure. This makes it more stable than the normal one by a
difference of 1 in ∆G.

The factor values are based on unpublished experimental results.
You can change them to suit your specific applications.

The values used for ∆G are of the most stable secondary structure of
all. If any of the secondary structures from amongst the all is not
formed, a 0 value is assigned to the ∆G of that secondary structure.

Aligning Sequences
The following section applies only to the Windows version of
Primer Premier.  For the Macintosh version, alignments are done
using the web and then loading the aligned sequence.  Complete
information for doing this is contained in the Primer Tour.

The Align window allows you to select which of the currently opened
sequences to use in the alignment.  The Selected Sequences box
displays all of the sequences that will be aligned.  Use the Add and
Delete buttons to add or remove sequences.

Use the Options button to open the Alignment Parameters Window.

Alignment Parameters

The alignment Parameters Window allows you to set all of the
parameters used by ClustalW in optimizing the alignment.  The
alignment can be done in 2 modes, slow/accurate and
fast/approximate.  As the names imply the slow/accurate is a more
algorithmically intensive alignment that is more accurate but takes
longer.  Depending on which mode is selected, a different set of
pairwise alignment parameters are available.

SLOW/ACCURATE alignment parameters

These parameters do not have any affect on the speed of the
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alignments. They are used to give initial alignments which are then
rescored to give percent identity scores. These % scores are the ones
which are displayed on the screen. The scores are converted to
distances for the trees.

1) Gap Open Penalty: the penalty for opening a gap in the alignment.
2) Gap extension penalty: the penalty for extending a gap by 1
residue.
3) Protein weight matrix: the scoring table which describes the
similarity of each amino acid to each other.
4) DNA weight matrix: the scores assigned to matches and
mismatches (including IUB ambiguity codes).

FAST/APPROXIMATE alignment parameters

These similarity scores are calculated from fast, approximate, global
alignments, which are controlled by 4 parameters. 2 techniques are
used to make these alignments very fast: 1) only exactly matching
fragments (k-tuples) are considered; 2) only the 'best' diagonals (the
ones with most k-tuple matches) are used.

K-TUPLE SIZE: This is the size of exactly matching fragment that is
used. INCREASE for speed (max= 2 for proteins; 4 for DNA),
DECREASE for sensitivity. For longer sequences (e.g. >1000
residues) you may need to increase the default.

GAP PENALTY: This is a penalty for each gap in the fast alignments.
It has little affect on the speed or sensitivity except for extreme
values.

TOP DIAGONALS: The number of k-tuple matches on each diagonal
(in an imaginary dot-matrix plot) is calculated. Only the best ones
(with most matches) are used in the alignment. This parameter
specifies how many. Decrease for speed; increase for sensitivity.

WINDOW SIZE: This is the number of diagonals around each of the
'best' diagonals that will be used. Decrease for speed; increase for
sensitivity.

Multiple Alignment Parameters

These parameters control the final multiple alignment.  Each step in
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the final multiple alignment consists of aligning two alignments or
sequences. This is done progressively, following the branching order
in the GUIDE TREE. The basic parameters to control this are two gap
penalties and the scores for various identical/nonidentical residues.

1) and 2) The GAP PENALTIES are set by menu items 1 and 2.
These control the cost of opening up every new gap and the cost of
every item in a gap. Increasing the gap opening penalty will make
gaps less frequent. Increasing the gap extension penalty will make
gaps shorter. Terminal gaps are not penalized.

3) The DELAY DIVERGENT SEQUENCES switch, delays the
alignment of the most distantly related sequences until after the most
closely related sequences have been aligned. The setting shows the
percent identity level required to delay the addition of a sequence;
sequences that are less identical than this level to any other
sequences will be aligned later.

4) The TRANSITION WEIGHT gives transitions (A <--> G or C <--> T
i.e. purine-purine or pyrimidine-pyrimidine substitutions) a weight
between 0 and 1; a weight of zero means that the transitions are
scored as mismatches, while a weight of 1 gives the transitions the
match score. For distantly related DNA sequences, the weight should
be near to zero; for closely related sequences it can be useful to
assign a higher score.

5) PROTEIN WEIGHT MATRIX leads to a new menu where you are
offered a choice of weight matrices. The default for proteins is the
BLOSUM series of matrices by Jorja and Steven Henikoff. Note, a
series is used! The actual matrix that is used depends on how similar
the sequences to be aligned at this alignment step are. Different
matrices work differently at each evolutionary distance.

6) DNA WEIGHT MATRIX leads to a new menu where a single matrix
(not a series) can be selected. The default is the matrix used by
BESTFIT for comparison of nucleic acid sequences.

7) In the weight matrices, you can use negative as well as positive
values if you wish, although the matrix will be automatically adjusted
to all positive scores, unless the NEGATIVE MATRIX option is
selected.
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8) PROTEIN GAP PARAMETERS displays a menu allowing you to
set some Gap Penalty options which are only used in protein
alignments.

Further Information
For more information on setting parameters and the ClustalW
algorithm, complete documentation is available from the author at:

http://www-igbmc.u-strasbg.fr/BioInfo/ClustalW/clustalw.html

Translation
Active Sequence

The list box on the GeneTank window contains the original sequence
and the results of any translations performed on the original
sequence.

Mechanisms to generate translations are as follows:

Translated DNA: You translate an Original Protein into DNA. You
translate Original DNA into Protein then back-translate it to DNA.

Note: If you translate a sequence more than once, only the last translation
will be kept. Prior translations will be discarded.

Translated Protein: You translate an original DNA into protein. You
translate Original Protein into DNA then back-translate it to Protein.

DNA Translation Button
This button is not available if the selected sequence is Original or
Translated DNA. If it is a protein, Codon Table Selection window
opens. You can select a codon table and reading frame.

Common degenerate bases listed in Appendix B of this manual are
used when the translation is ambiguous.
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Alternate Access:
Translate > To DNA

Protein Translation Button
The button is not available if the selected sequence is Original or
Translated Protein. If it is DNA, codon tables selection window opens.
You can select a codon table and reading frame.

If a base triplet does not translate into an amino acid due to ambiguity
in the bases, the character * is used to indicate the indeterminate
translation.

Alternate Access:
Translate > To Protein

Edit Codon Table Window
With this window, you can create new codon tables, delete codon
tables or modify existing codon tables. PRIMER PREMIER supplies
the standard (universal) table, which cannot be modified or deleted.

 button creates a codon new codon table using the standard
codon table with the name <New Organism: some number>.
You can change the name by using the Edit Codon Table Name

box.  button deletes the selected codon table.  To change
the position of a codon, simply grab it and drag it to the desired place.
On grabbing the codon the cursor changes its shape to indicate that
you have grabbed it. When you drop the codon on to its new home,
the consensus codon changes in both rows, the row that lost it and
the row that gained it.
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Primer
Primer function contains the main search engine that designs primers.
The powerful automatic search algorithm is designed to yield the very
best primers with just a few mouse clicks. If you have unique
experimental needs, PRIMER PREMIER yields the complete control
of the search engine to you so that you can drive it manually, using
your own criteria. The resultant primers can be analyzed with
comprehensive on-line analysis facilities that dynamically calculate
several primer properties and analyze secondary structures. Critical
properties such as Tm, GC % and ∆G can be displayed as graphs.
There is another window added to show the activity (in nmoles/OD
and µg/OD) and Molecular weight of current primer pair. Selected
primers can be saved to the database, printed or ordered with the
synthesis order form.

To design primers for site-directed mutagenesis, the function provides
primer editing facilities with instant analysis and update of restriction
enzyme analysis. You can change the primers by entering bases or
amino acids.

To check for a number of primers in a reaction i.e., for a
multiplex/nested PCR, you can analyze as many primers as you want,
using Multiplex/Nested function. You can select different primers from
an earlier search and can also add primer sequences manually.

Facilities to store primers of interest in the database are provided. A
function to fill out a form for ordering synthesis of selected primers
which automatically fills-in the primer sequence and other pertinent
information is provided.

The function has the following sections:
Preferences Window
Primer Premier Window
Edit Primer Window
Search Criteria Window
Search Parameter Windows
Search Results Window
Multiplex/Nested Primer Window
Database Window
Synthesis Order Form
Reports
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Graphs

Primer Premier Window
This window is your key to the analysis of primers. The three major
sections of the window; direct select, table of properties and
secondary structures are described below:

Direct Select Box
When you move your cursor over the box, the cursor changes its
shape from an arrow to a pencil. Clicking anywhere in the box selects
a primer with sequence number closest to the place where you
clicked and with the strand selected using the Strand box. All the
properties are instantly updated. The Primer is displayed on the
sequence along with the ends of primer marked as 5' and 3'. This
helps in easy identification of the direction of amplification.

If direct select is used on an aligned sequence, the sequence of the
primer is taken from the majority consensus.  This allows easy
visualization of where the primer may have mismatches with any
particular sequence.

Direct Select with an Alignment
When doing highly conserved sequence primer design, Primer
Premier displays the alignment on the Primer window to allow easy
visualization of mismatches between the primer and each template.
Clicking anywhere on the sequence creates and analyzes a primer
that matches the Majority Consensus.  The primer can then be edited
using edit primer to match any specific sequence.  This allows easy
creation of allele specific primers.

The view of the Majority or Minority Consensus can be toggled from
the View menu.  The Minority Consensus allows visualization of which
nucleotides do not have a perfect match among all of the aligned
sequences.

Table of Properties
The table shows the properties of the currently selected pair. You can
select a pair using one of the following three ways:

Direct Select Box: Select a primer as described above,
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change the strand and select again to select a pair.
Choose a pair in the Search Results window.
Choose a pair in the database window by importing it.

Note: Instead of choosing a pair, let us say that you only chose a sense
primer using one of the above methods. Then you are pairing the newly
chosen primer with the anti-sense primer of the pair you were working on just
before you made the new primer selection.

The property table updates the rating, sequence number, length of
the primer, its melting temperature Tm, GC %, the degeneracy, the
optical activity of sense and anti-sense primers in micrograms/OD.
For the pair the length column shows the PCR product length and the
Ta Opt column shows the optimum annealing temperature for PCR.

Please see Appendix A for the formulas used for calculating the
properties.

Secondary Structures
PRIMER PREMIER instantly analyzes secondary structures and the
matrix of buttons shows you which structures are found. The
depressed button indicates which structure is displayed in the
neighboring box. Along with the secondary structure the window also
displays the ∆G (in kcal/mol) of that structure.

Note: For hairpins, dimers, false priming or cross dimers to exist, it is
assumed that at least three consecutive bases must bond.

The most stable structure is displayed in the box on the PRIMER
PREMIER window. Consecutive bonds are shown with solid lines and
non-contiguous with broken lines.

Pressing the  button opens the report of the structure you have
selected. For example, if you were looking at the hairpins of sense
primers the following window will open:
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The structures appear in the order of decreasing stability, the most
stable structure being the first. Scroll bars are available to study the
structures in detail.

Apart from these functions there are three buttons for going directly to
Search Criteria Window, Search Results Window (if a search has
already been performed) and Edit Primer Window. Along with these
buttons the portion amplified due to the selected primer pair is also
displayed pictorially.

Edit Primer Window
Edit primer function provides you assistance in designing a primer for
site directed mutagenesis and analyzing a pre-existing primer.

You can cut, copy and paste using the keystroke short cuts: CTRL-X,
CTRL-C and CTRL-V for Windows and Command-X, Command-C
and Command-V on Power Mac. The best way to analyze an existing
primer is to delete the current primer and paste the existing primer
through the clipboard. On pasting, Paste window opens, , which can
used to reverse, complement or reverse complement the primer
sequence. You can also type in the primer. As soon as the primer is
edited, the previous results go away and the Analyze button
becomes enabled. Clicking the Analyze button analyzes the current
primer.

You can modify the primer by using the actual sequence or the amino
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acid translation. If you use amino acid for placing bases for primer,
the codon that is placed for a particular amino acid is the degenerate
one.

In addition to the properties and secondary structure data (see
PRIMER PREMIER window section for additional information),
restriction enzyme analysis is available on this window. You can
change the enzyme set by clicking the Enzyme button and modifying
the set using the buttons or filter.

You can move your primer to next equal or more stable binding site.
This can be achieved by pressing the Prime button. This can be used
to confirm that no binding sites, which are equally or more stable than
the existing site, are present.

Insider Info: If you want to change the reading frame or the codon
table for the translation, close this window. Choose Function >
GeneTank from the menu to make the GeneTank window active.
Choose Translate > Change Parameters to open the Select Codon
Table window. Change the reading frame and/or the codon table and
reopen this window.

Alternate Access: 
Function > Edit Primer

Search Criteria Window
The basic criteria for the search are specified here:

If you intend to use the primers for PCR, for sequencing or as
hybridization probes, it is important to choose the appropriate Search
For criteria to reflect it. PRIMER PREMIER adjusts the automated
search parameters based on this selection.

The parameters, which optimize the ability of primer pairs to extend
well, are not applicable if you are designing primers for sequencing or
hybridization experiments. In addition, higher annealing temperatures
are desirable. PRIMER PREMIER makes the adjustments to the
parameters appropriate to your application when you make your
selection in the Search For criteria. Please see the Automatic
Search Parameter section below for the actual values used by the
search algorithm.
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The Search Type box should be used to indicate whether you want
to search for single primer, both primers, primer pairs or whether you
only want to search for a primer to pair with the currently selected
primer.

By default, the Search Range is set to search the entire length of the
loaded sequence. The range for PCR product length is set to a
reasonable arbitrary value of 100 bp to 500 bp by default. If you are
searching for single primers this value is ignored.

You can also set the Primer Length range for the search. Please
refer to the discussion in the next section on how this parameter is
used in search.

Finally, you can choose the Search Mode to be automatic or manual.
Unless you have unique needs or desire greater control over certain
parameters, you should choose the automatic search and let
PRIMER PREMIER come up with a reasonable set of primers. You
can then analyze the set in detail to pick the primers that suit your
needs.

Alternate Access: 
Function > Search

Search Parameter Windows
The search can be carried out using either automatic search method
or manual search method.

When you want to search for primers on a sequence such that the
primers should not bind (i.e., should not false prime) to any other
sequence present in your reaction you can select them by pressing
Files button.

Automatic Search
You can select which parameters are used in the search, although
the PRIMER PREMIER determines their values automatically.
Blanking the check box next to the parameter excludes the parameter
as a search criterion.
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Automatic search starts with the stringency control set Very High. If
the search does not yield any primers, the stringency is dropped a
notch until primers are found. The following table shows the initial
(Very High Stringency) values used in automatic search when you are
searching for PCR Primers. The Tm range is based on the average
of Tm 's of all possible primers for the sequence within the sequence
number range selected for the search:

Note: Tave is the average of Tm 's of all possible primers for the sequence within
the sequence number range selected for the search.

If you are searching for Sequencing Primers the values which differ
from the above table are:
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If you are searching for Hybridization Probes the values which differ
from the table for PCR primers are:

Insider Info: If you select Manual Search and click the Stringency buttons,
you can get an on-line display of the tables above.

Manual Search (Science of Primer Design)
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PCR methods have been evolving over the past ten years to allow the
most efficient amplifications possible.  Improvements in our
understanding of primer stability, primer dimer formation, and optimal
primer length have led to progressively higher PCR efficiencies while
maintaining adequate specificity. The PRIMER PREMIER search
algorithm maintains a balance between the goals of specificity and
efficiency.

Primer Length
Along with the annealing temperature of the PCR reaction, the length
of the primer primarily controls the specificity. For most experiments,
primers between 18 and 24 bases are optimal to use. Short primers
of 15 bases or less are sometimes used for mapping simple genomes
or other specialized library protocol. 28-35 bases long primers are
necessary for amplifying sequences encoding closely related
molecules or cloning genes from different species.

Longer PCR primers result in increased specificity during
amplification.  This allows the use of lower annealing temperatures,
improving the sensitivity of the reaction.  However, longer primers are
more likely to form secondary structures including hairpins, dimers,
and self-complementation.

Ideally, the shortest primer with melting temperature in the desired
range provides the best balance between specificity and efficiency.

PRIMER PREMIER ships with reasonable values for the primer
length range. If you change them, it remembers your new values and
continues using then until you change them again. It is, therefore,
important for you to enter a range based on the specificity required by
your application.

PRIMER PREMIER starts the search with the primer lengths at the
minimum acceptable value. If the Tm is lower than the desired Tm
range or GC % is not within the desired range, it adds a nucleotide
making it longer. It recalculates the Tm and GC % and tests them to
see if they fall within the acceptable ranges. If not, it continues adding
to the length until the maximum length is reached. If the Tm and GC %
are still not within the acceptable range, it rejects the primer. This
search algorithm ensures finding the shortest possible primers
consistent with desired Tm and GC %.
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In designing an efficient primer, several parameters should be
considered. The order in which PRIMER PREMIER searches these
parameters follows:

Tm (Melting Temperature)
PRIMER PREMIER calculates melting temperature using nearest
neighbor theory. Please see Appendix A of this manual for the
formula. The range of Tm selected should provide sufficient thermal
window for annealing. The algorithm used by PRIMER PREMIER for
choosing a range for automatic search is:

First, Tm’s of all possible primers for the sequence along the region
selected for the search are calculated. An average Tm is computed. A
range for each stringency is calculated around this average by using
reasonably tight numbers.

A reasonable range for values of Tm for PCR is 56-63 °C according to
the published experimental data[8]. The above algorithm is devised to
guarantee finding reasonable number of primers within the desired
range.

GC %
Around 50% GC content is reasonable for PCR, while for sequencing
primers and hybridization probes the GC content should be at least
50% or higher. The tables in the Automatic Search section above
show the exact numbers used for each type of search.

Degeneracy
When designing degenerate primers, primers with least degeneracy
are more desirable because they provide greater specificity. It is also
critical to avoid degeneracy at the 3’ end, because even a single base
mismatch can prevent extension.
For further details, please see the Degeneracy chapter of this
manual.

3’ End Stability
The stability of the primer determines its false priming efficiency.  An
ideal primer has a stable 5' end and an unstable 3' end.
If the primer has a stable 3’ end, it will bond to a site that is
complementary to it other than the target with its 5’ end hanging off
the edge. It may then lead to secondary bands.
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Primers with low stability at the 3' ends function well because the 3'
end bonding to false priming sites are too unstable to extend.

GC Clamp
Stability of the 5' termini allows for efficient bonding of the primer to
the target site.  This stable 5' region is called the GC Clamp.  It
ensures adequate binding of the primer to the template.  Use of
primers with optimal stability allows for the use of lower annealing
temperatures without the production of secondary bands.

The internal stability graph of a good primer using Report > Internal
Stability menu item is shown:

Notice that the 3’ end has low stability and the 5’ end has a strong GC
clamp.

Repeats and Runs
PRIMER PREMIER automatically rejects any primers with 3 or more
dinucleotide repeats. For example, if the primer contains ATATAT,
dinucleotide AT is repeated three times, the primer is rejected. You
can set the number of single base runs that are acceptable.

Secondary Structures
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An important factor to consider in the design of a primer is the
presence of secondary structures.  Secondary structure can greatly
reduce the number of primers available for bonding in the reaction.
The presence of hairpin loops in a primer reduces its efficiency by
limiting its ability to bond to the target site.  Primers that have formed
loops are unavailable for bonding to the PCR products.

Hairpin:

A hairpin loop is formed when primer folds back upon itself and
is held in place by intramolecular bonding.  Because hairpin loop
formation is an intramolecular reaction, it can occur with as few
as 3 consecutive homologous bases.  To measure the stability of
the hairpin loop formed, measure the free energy.  The free
energy of the loop is based upon the energy of the
intramolecular bond and the energy needed to twist the DNA to
form the loop.  If this free energy is greater than 0, the loop is too
unstable to interfere with the reaction.  If the free energy is less
than 0, the loop could reduce the efficiency of amplification.  The
Hairpin Report accessed using the  button on the PRIMER
PREMIER window allows you to avoid primers containing
secondary structure.

Dimer:

Dimers occur when a region of homology is present within a
primer or between two primers.  This results in bonding of the
two primers, increasing production of the primer dimer artifact
and reducing product yields.
Dimers can occur within a primer when two copies of the primer
bind to each other or  when a primer binds to the other primer in
the pair.  This is particularly problematic when the homology
occurs at the 3' end of either primer.  The 3' end will extend
readily leading to primer dimer artifact.  The Dimer Report can be
used to test for formation of dimer duplexes.

False Priming:

If the primer binds anywhere other than the target site, the
amplification specificity is reduced significantly. The product is
weak or a smear is observed. PRIMER PREMIER examines the
entire sequence for each primer to identify potential false priming
sites. The propensity for false priming is higher if the 3’ end can
form consecutive bonds than if the same number of bonds can
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form upstream of the 3’ end. You can choose separate screening
criteria for number of bonds at the 3’ end and for the entire
primer.

Pair Rating
Poorly matched primers are less specific because the primer with
lower Tm determines the specificity of the amplification. The primer
with higher Tm has a greater chance of mispriming resulting in
secondary banding. PRIMER PREMIER calculates a rating for each
pair, 100 being a perfect match, and presents the pairs in the order of
decreasing rating.  Appendix A contains the formulas used for the
rating calculation of primer pairs as well as individual primers.

Search Results Window
When you accept the results of the search by clicking OK on the
Search Progress window the Search Results window opens. It shows
all the primers and or pairs found with the search.

As you select a primer or a pair, it is instantly analyzed and the
analysis appears on the PRIMER PREMIER window. The location
and the sequence of the primer with the selected strand appear in the
Direct Select box.

Insider Info: Change the size and the location of the Search Results window
relative to the PRIMER PREMIER window which shows the analysis so that
the properties you are interested in are not blocked by the window.

Alternate Access: 
Function > Search Results

Multiplex/Nested Primer Window
Nested PCR is often successful in reducing unwanted products while
dramatically increasing sensitivity. It is often used when the actual
quantity of target DNA is very dilute or not very pure.

You first run a search using automatic mode or tailoring it to your
experimental needs. You are then ready to select a compatible set of
nested primers from this pool. PRIMER PREMIER assists you in
selecting multiple or nested primers from the pool by ensuring that
they are free of cross dimers.
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After you accept the results from a search, choose Function >
Multiplex/Nested Primers from the menu to open this window:
The entire sequence and all the primers found are shown in graphical
form at the top of the window. The box indicates the portion of the
sequence magnified in the center of the window. You can change the
region magnified by using the horizontal scrollbar at the bottom of the
magnified region.

The available primers appear as vertical lines in the top box and as
blue and red hollow triangles in the magnified region. As always, blue
represents sense primers and red anti-sense.

Click on the triangle representing a primer you want to select for your
multiplex experiment. The triangle changes from hollow to filled
indicating your selection. That primer appears in the bottom box as a
selected primer both in graphical and tabulated form.

Notice that as soon as you make your selections the cross dimers are
displayed which are formed between the selected primers. PRIMER
PREMIER instantly analyzes all the selected primers and displays the
cross dimers that are formed in between the primers you have
selected. Continue your selection until you have a set with no or less
stable cross dimer. To deselect a previously selected primer, simply
click on the solid triangle representing it and it will be deselected.

You can also add primers manually. This is useful if you already have
primers in your lab or working with published primer sequences. You
can add all your primers manually and check any combination of
primers in the pool that form cross dimers.

You can define that the input oligo is a sense primer or an anti-sense
primer, its sequence number and the sequence. If the sequence
number is not specified, it is defaulted to 5' sequence number of first
base. If you wish to delete a primer, select it and press the Delete
button.

You can print the target sequence showing all primers on the
sequence.  Select primers are displayed as filled triangles, unselected
primers as hollow triangles.  Primers appearing in table and all
possible cross dimers can also be printed.
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Database Window
The Primer Database allows you to store the sequences of primers.
You can name individual primers and save them to a new database
set or append them to an existing database set. Primers can be
ordered directly from database window using the Order Primers
button.

There are two primary ways to get your selection into the database.
You can mark the primers on the Search Results window and then

import the primers into the database using the  (Get Marked
Primers) button or  you can select a primer directly and export it
through the Current Primer Pair box.

The database remembers the sequence number, sequence, strand
and the name of the primer. Editing of any of the primers name,
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sequence, sequence number and strand can be done by selecting the
primer to be edited and then selecting edit primer option from menu

or .

If you open a database set by selecting it from the drop down box,
with previously saved primers, you can analyze them with the
currently loaded sequence by selecting the primer and making it the

current selection, using  button. Once the primer is
selected, you can use PRIMER PREMIER window to analyze it or edit
it.  You can automatically find the most stable priming site on the new
sequence be using the prime button on the Edit Primer Window.

You can add new database sets with different names.   This makes it
easy to keep primers stored by target gene or projects.  Similarly you
can also delete any primer database set which was created earlier.

New primers can be added directly by pressing the  (Add Primer)
button. This will popup a window where you enter the primer name,
strand, sequence number and the oligo sequence. If the sequence
number is not given it is defaulted to 5' sequence number of first
base.

Reports
Several reports are available through the Reports menu. In addition to
the secondary structure reports which are also available by clicking

 on the PRIMER PREMIER window, an activity report and an
internal stability report is available for the currently selected primers.

When you select Optical Activity from Report menu a window
displaying the Molecular Weight and Activity (in nmol/OD and µG/OD)
for the current primer pair selected opens.

When you move the cursor on the internal stability graph, a broken
line snaps to the nearest valid sequence position and the readout box
is updated. The pentamer is highlighted as well.

The graph window can be resized to adjust the amount of detail
viewed.
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A window opens when you select Hybridization Time from Report
menu. You can enter the primer length and concentration of interest
and click the Analyze button to get hybridization time.

Synthesis Order Form
After searching and analyzing primers, if you decide to order primers
for synthesis, you can use the synthesis order form. A sample form is
provided for your convenience.

You can open a new form and enter your shipping and billing
information and save it under a new name. You can use this form as
a template for all of your orders. The Database window is used to
select the primers you wish to order. Simply select the primers to be
ordered, open the form, by pressing  button, with the correct
shipping and billing information, PRIMER PREMIER will automatically
add the sequence of the primers you have selected on the Database
window in the appropriate place on the synthesis form. Add remarks,
print it and send it on its way.

Save the form so that you can re-open it.

Optical Activity
The absorbance at 260 nm, A260, is proportional to the primer
concentration, with a value of 0.02 units per microgram DNA per
milliliter. The molecular weight of a primer is also available. This
makes it easy to calculate dilution factors for newly synthesized
oligonucleotides.

Molecular Weight - This is the molecular weight of both the
primers in grams/mol. It is calculated from the table of
molecular weights.
nmol/A260 - This is the concentration of primer in nanomoles
per unit absorbance (OD) at 260 nm. It is calculated from table
of extinction coefficients and molecular weights.
µg/A260 - This is the concentration of primer in micrograms per
unit absorbance (OD) at 260 nm. It is calculated from table of
extinction coefficients.
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Degeneracy
Some PCR applications require that primers bind to an unknown
sequence. Here are several possible situations:

Expressed protein known but DNA has not been sequenced.
Template DNA is poorly sequenced or the sequencing is
incomplete.
The coding region that needs to be amplified has been
identified in another organism.
Consensus sequence from multiple species for the template
DNA is available.

When designing degenerate primers, along with all the parameters
mentioned in the Search Parameters, the degree of degeneracy
within the primer must be considered. The primers with the least
degeneracy are more desirable because they provide greater
specificity. It is also critical to avoid degeneracy at the 3’ end,
because even a single base mismatch can inhibit extension. PRIMER
PREMIER automatically scans the target DNA sequences and
designs primers in regions of low degeneracy that are checked for the
overall percentage of ambiguous bases as well as number of
ambiguous bases occurring at the critical 3' end(13).

It has been reported that the PCR thermal profile can dramatically
alter the success rate of degenerate PCR. The preferred degenerate
PCR amplification profile starts with a non-stringent annealing
temperature (35-45 °C) for 2-5 cycles, followed by 25-40 cycles at a
more stringent annealing temperature. The relaxed annealing
conditions allow the short complementary primer portion to hybridize
to the target. After the second cycle of amplification, the 5’ extension
becomes incorporated into the amplified product and will serve as the
template for subsequent rounds of amplification. By shifting to a more
stringent annealing temperature, increased specificity can be
achieved(9).

Graphs
The graphs of Tm, GC % and internal stability for the entire sequence
are available through the Graph menu. Tm is the melting temperature
of all potential primers with the default length of primer as set in
Preferences window. GC % is the GC content of all potential primers.
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Internal stability is the free energy of pentamers located at each
position of the sequence.

When you move the cursor on the graph, a broken line snaps to the
nearest valid sequence position and the readout box is updated. The
primer or the pentamer is highlighted as well.
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Restriction Enzyme Analysis
A set of approximately 900 common enzymes is supplied with
PRIMER PREMIER for your convenience. Easy to use facilities to add
to this set are provided as well. By accepting/rejecting enzymes from
the available enzyme set, you can create a current set. Alternatively,
you can use filter to specify properties of enzymes to create the
current set. The current set is used for restriction enzyme analysis.
The analysis is displayed in several formats: table, map or sequence.

The function has the following sections:

Restriction Enzyme Analysis Window
Filter Window
Edit Window

Restriction Enzyme Analysis Window
Approximately 900 commonly used enzymes have been supplied with
PRIMER PREMIER for your convenience. You can add or delete
enzymes to the All Enzymes set using the Edit function.

The Selected Enzymes box displays the currently selected set of
enzymes, which is subset of All Enzymes. The Selected Enzyme set
is used for analysis. There are two ways of choosing the current set:

1. Select enzymes you want to add to the current set by selecting them
in the All Enzymes box. You can use CTRL key on Windows and
Power Mac while clicking to choose multiple enzymes. To choose a
range of enzymes, select the first enzyme by clicking and then select
the last enzyme in the range by pressing SHIFT key while clicking.

Press  button to add the selected enzymes to the current
set. Selecting enzymes in Selected Enzyme box and pressing

 button deletes the selected enzymes from the current set.
You can also double click on an enzyme in the All Enzyme box to
add it to Selected Enzyme box or double click on an enzyme in
Selected Enzyme box to delete it.

2. Use filter window to choose the current set by specifying the desired
properties. See the section on the Filter window for details.
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Restriction Sites Window
Pressing OK button on the Restriction Enzyme window opens up
the Restriction Sites window.

Available displays are:
Table: Lists the enzyme, its recognition sequence, number of
cut sites and the location of cut sites.
Sequence: Shows the exact location of the cut site for each
enzyme on the sequence.
Map: Represents the sequence graphically with a rectangle
and shows the location of the cut sites for each enzyme with
vertical lines.
Non-cutters: Lists the enzymes of the current set which do not
cut the sequence at all or which do not qualify the set criterion.
You can filter the display of enzymes by selecting to display
enzymes with specific number of cut sites. For example, if you
choose the 4 box, the enzymes that cut the sequence 5 or
more times will be eliminated from the display.

Note: If an enzyme cuts the sequence for more than 50 times, only the first 50
cuts are shown and the rest are ignored.

You can print Table, Sequence or Non-cutters by selecting File >
Print from the menu.

Edit Enzyme Window
To modify an enzyme in the All Enzymes set, select the enzyme and
press Edit button. This will bring up Edit Enzyme window where
enzymes name, recognition site or heat activation can be changed.
To add an enzyme, click on Add button and a window opens with a
default name and recognition site for the enzyme. The Delete button
will delete the selected enzyme.

Press the OK button to accept all changes and return to the
Restriction Enzyme Analysis window.

Note: There is no need to press OK after each change. All changes are
remembered as you make them. Press OK to accept them all or Cancel to
undo all the changes you made in this session.
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Filter Window
You can create the current set for use in the analysis by specifying
the desired properties of the enzymes.

Specify the recognition site length between 4 bp to 13 bp by choosing
the appropriate boxes and the Selected Enzymes box is instantly
updated to include only the enzymes that satisfy your criterion.

You can specify the type of overhang and the overhang sequence if
you wish. The table showing the conventions used to specify the
overhang follows:

You can also choose whether the Selected Enzyme set is heat
sensitive or not by choosing Heat Inactivation box.
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When you press OK, the Selected Enzyme set becomes the current
set of Selected Enzymes on the Restriction Enzyme Analysis
window and you are ready to analyze the cut sites using this set.
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Motif Analysis
A set of approximately 165 common motifs is supplied with PRIMER
PREMIER for your convenience. Easy to use facilities to add to this
set are provided as well. By accepting/rejecting motifs from the
available motif set, you can create a current set. The current set is
used for motif analysis. The analysis is displayed in several formats:
table, map or sequence.

The function has the following sections:

Motif Analysis Window
Edit Window

Motif Analysis Window
Approximately 150 commonly used motifs have been supplied with
PRIMER PREMIER for your convenience. You can add or delete
motifs to the All Motifs set using the Edit function.

The Selected Motifs box displays the currently selected set of motifs,
which is subset of All Motifs. The Selected Motifs set is used for
analysis. You can choose the current set in the following manner:

Select motifs you want to add to the current set by selecting them in
the All Motifs box. You can use CTRL key on Windows and Power
Mac while clicking to choose multiple motifs. To choose a range of
motifs, select the first motif by clicking and then select the last motif in

the range by pressing SHIFT key while clicking. Press 
button to add the selected motifs to the current set. Selecting motifs in

Selected Motif box and pressing  button deletes the
selected motifs from the current set. You can also double click on an
motif in the All Motif box to add it to Selected Motif box or double
click on an motif in Selected Motif box to delete it.

Motif Sites Window
Pressing OK button on the Motif Analysis window opens up the
Motif Sites window.
Available displays are:
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Table: Lists the motif, its recognition sequence, number of sites
and the location of sites.
Sequence: Shows the exact location of the site for each motif
on the sequence.
Map: Represents the sequence graphically with a rectangle
and shows the location of the sites for each motif with vertical
lines.
Motifs Absent: Lists the motifs of the current set which do not
appear in the sequence at all or which do not qualify the set
criterion.

You can filter the display of motifs by selecting to display motifs with
specific number of sites. For example, if you choose the 4 box, the
motifs that appear 5 or more times in the sequence will be eliminated
from the display.

Note: If a motif appears in the sequence for more than 50 times, only the first
50 sites are shown and the rest are ignored.

You can print Table, Sequence or Motifs Absent by selecting File >
Print from the menu.

Edit Motif Window
To modify a motif in the All Motifs set, select the motif and press Edit
button. This will bring up Edit Motif window where motif name,
recognition sequence and description can be changed. To add a
motif, click on Add button and a window opens with a default name
and recognition sequence for the motif. The Delete button will delete
the selected motif.

Press the OK button to accept all changes and return to the Motif
Analysis window.

Note: There is no need to press OK after each change. All changes are
remembered as you make them. Press OK to accept them all or Cancel to
undo all the changes you made in this session.
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Menu Commands
Each of the main functions has it own menu:

GeneTank Menu
Primer Menu
Enzyme Results Menu
Motif Results Menu

GeneTank Menu

File
New Sequence: Opens GeneTank window with a blank
sequence.
Open Sequence: Prompts you for a file to use and opens the
sequence.
Save: Saves the loaded sequence to a file. You can open a
saved file without going through the Import Window.
Save As: Saves a copy of the loaded sequence to the chosen
file.
Degenerate Bases: Lists the table of all allowed degenerate
bases with their meanings.
Print: You can print the sequence in various formats with various
combinations.
Quit: Exits PRIMER PREMIER.
List of last four opened files.

Edit
Standard cut, copy, and paste menu items.
Preferences: Lets you choose parameters that apply to the entire
product.

View
Show Header: Displays the header of the loaded sequence in
the GeneTank window.
Sense Strand: Displays the sense strand of the loaded
sequence.
Anti-sense Strand: Displays the anti-sense strand of the loaded
sequence.
ds DNA: Displays both the sense strand and anti-sense strand of
the loaded sequence.
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Grouping: Choose the grouping of the bases of the sequence to
be 3 or 10.
5’ Seq no: Renumbers bases of the sequence starting from 5`
end.

Search
Find: Finds occurrences of the pattern within the sequence
starting from the current position.
Find Next: Finds the next occurrence of the pattern within the
sequence.
Go To Position: Places the cursor at the specified position in the
sequence.

Function
Primer Design: Designs primers according to parameters set
after selecting this function.
Restriction Enzymes: Performs restriction enzyme analysis
according to the set parameters.
Motifs: Performs motif analysis according to set parameters.
Bias majority by: When no single base has a majority the
sequence from this base is used.
Speaker: Voice readback of sequence.

The menu lists the functions available to you, except the function you
are using.

Translate
To DNA: Translate loaded protein sequence to DNA.
To Protein: Translate loaded DNA sequence to protein.
Change Parameters: Change reading frames or codon table for
translation.
Edit Codon Table: You can add, delete or modify codon tables.

Window
The menu lists all of the windows that are open, except the one that is
active. When you select a window in the list, it becomes the active
window.

Help
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Use this menu to view on-line help. The information contained in the
help is substantially the same as the information available in this
manual. It has been formatted for on-screen viewing and contains
hypertext links to enable you to jump to relevant topics. It also
contains search facility to locate topics.
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Primer Menu

File
Preferences: Lets you choose parameters that apply to the entire
product.
Degenerate Bases: Lists the table of all allowed degenerate
bases with their meanings.
Print: You can print the sequence in various formats with various
combinations.
Quit: Exits PRIMER PREMIER.

Edit
Find: Finds occurrences of the pattern within the sequence.
Find Next: Finds next occurrence of the pattern with in the
sequence.

Function
Search: Opens the Search Criteria window to set parameters
and start primer search.
Search Results: Makes the Search Results window active if you
have completed a search.
Edit Primer: You can add, delete, modify the primer sequence
and analyze it instantly. You can also move the primer to the
next best false priming site.
Multiplex/Nested: Choose compatible nested sets of primers
from search results and can also add or delete new primers and
check with the existing set of selected primers.
Database: You can add, delete or modify the existing database
of primers. You can edit the strand, name, sequence number or
sequence of a primer. You can also order primers of from any
database.

After the line that separates the above menus, three functions
(GeneTank, Restriction Enzymes and Motifs) are listed.

Report
Hairpin: Shows all hairpin structures for currently selected sense
or anti-sense primer.
Dimer: Shows all dimer structures for currently selected sense or
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anti-sense primer.
False Priming: Shows all false priming sites for currently selected
sense or anti-sense primer.
Internal Stability: Draws a graph of internal stability of pentamers
along the currently selected sense or anti-sense primers.
Optical Activity: Shows the molecular weight and optical activity
of the primer.
Hybridization Time: This will calculate the hybridization time for a
specific primer length and concentration.

Graph
Melting Temp (Tm): Draws a graph of the Tm for the entire
sequence.
GC %: Draws a graph of the GC% for the entire sequence.
Internal Stability: Draws graphs of stability of 5 mers in (-
Kcal/mol).

Window
Please refer to the explanation in GeneTank.

Help
Please refer to the explanation in GeneTank.
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Enzyme Results Menu

File
Preferences: Lets you choose parameters that apply to the entire
product.
Degenerate Bases: Lists the table of all allowed degenerate
bases with their meanings.
Print: You can print the sequence in various formats with various
combinations.
Quit: Exits PRIMER PREMIER.

Function
Restriction Enzymes: Performs restriction enzyme analysis
according to set parameters.
GeneTank: Displays GeneTank window.
Primer Design: Design primers according to parameters set after
selecting this function.
Motifs: Performs motif analysis according to set parameters.

Window
Please refer to the explanation of the same menu in GeneTank.

Help
Please refer to the explanation of the same menu in GeneTank.
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Motif Menu

File
Preferences: Lets you choose parameters that apply to the entire
product.
Degenerate Bases: Lists the table of all allowed degenerate
bases with their meanings.
Print: You can print the sequence in various formats with various
combinations.
Quit: Exits PRIMER PREMIER.

Function
Restriction Enzymes: Get restriction enzyme analysis done
according to set parameters.
GeneTank: Displays GeneTank window.
Primer Design: Design primers according to parameters set after
selecting this function.
Motifs: Get motif analysis done according to set parameters.

Window
Please refer to the explanation of the same menu in GeneTank.

Help
Please refer to the explanation of the same menu in GeneTank.



Primer 5.0 Manual Reference

46

Appendices
Appendix A: Formulas and Algorithms
Appendix B: Degenerate Code
Appendix C: Amino Acid Symbols
Appendix D: Software Limits
Appendix E: References
Appendix F: System Specifications



Appendix A: Formulas and Algorithms

47

Appendix A: Formulas and Algorithms
Formula for Determining Melting Temperature of Primer (Tm of
Primer)
Melting temperatures are based on nearest neighbor thermodynamic
theory. The formulas are from the paper by Freier et al (7).  These are
highly accurate nearest neighbor based Tm calculations. Several
corrections have been incorporated into the formula to yield the most
accurate results possible.

Tm = ∆H/(∆S + R * ln (C/4)) + 16.6 log ([K+]/(1 + 0.7 [K+])) - 273.15

∆H is the enthalpy for helix formation.
∆S is the entropy for helix formation.
C is the DNA concentration.
[K+] is the salt concentration.

∆H and ∆S for the respective oligo are calculated using the values of
nearest-neighbor thermodynamics from Breslauer, K.J. (2). Since the
thermodynamic values calculated by Breslauer, K.J. are at 1 M Na+, it
was necessary to add a term to correct for salt concentration, [K+].
[K+] is calculated using both the monovalent ion concentration and the
free Mg2+ concentration. The value of [K+] is determined using the
formula:

[K+] = Monovalent ion concentration + 4 X √ Free Mg2+ ion
concentration X 1000

The salt concentration i.e., [K+] is represented as Total Na+ Equivalent
in the preferences window and it gets updated according to the
changes made in either Monovalent ion concentration or Free Mg2+

ion concentration. The default values of Monovalent ion concentration
and Free Mg2+ ion concentration are 50.0 mM and 1.5 mM res., which
gives a total salt concentration equal to 204.9 mM.

In the formulation of Freier et al. (7), c is the total molar concentration
of the annealing oligos, when oligos are not self- complementary. It is
neither the primer concentration nor the initial template concentration.
It is based on the PCR product concentration. Since the concentration
of template changes dramatically during the course of the PCR, it is
difficult to define the value of "c". It has been empirically determined
that setting the value of c = 250 pM, as suggested by Rychlik, W. et
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al. (11), gives good results in a wide variety of PCR and sequencing
reactions. This is set as the default value though you can change this
value from the Preferences window, which can be activated from File
menu.

Formula for Determining Melting Temperature of Product (Tm of
Product)
The melting temperature of the PCR product cannot be calculated
using the nearest neighbor model as it is only accurate for short
sequences such as oligonucleotides.  For calculating Tm of long
duplex DNA, the formula of Wetmur, J.G. is employed: (12):

Tm product = 81.5 + 16.6 log ([K+]/(1+0.7[K+])) + 0.41 (%G + %C) -
500/length

The salt concentration is taken from the Preferences Window (Total
Na [+] Equivalent), GC % are calculated and length of product is also
determined.

Formula for Determining Optimum Annealing Temperature Ta
Opt
PRIMER PREMIER automatically calculates the predicted optimal
annealing temperature for any given primer pair on a particular target
using the formula of Rychlik, W. (11).  Use of this temperature in the
annealing step of the PCR cycle usually results in optimal PCR
product yield with minimum false product production.

Ta Opt = 0.3 x (Tm  of primer) + 0.7 x (Tm  of product) - 25

where Tm of primer is the melting temperature of the less stable
primer-template pair and Tm of product is the melting temperature of
the PCR product, both calculated as shown above.

Formula for Determining Free Energy ∆∆∆∆G
Entropy and enthalpy calculations are based upon the
thermodynamic library of all 10 Watson-Crick DNA nearest-neighbor
interactions determined by Breslauer et al. (2). Using this method, the
free energy of an oligo is calculated from the enthalpies and entropies
of each dinucleotide in the oligo and the temperature defined in the
Preferences Window. The temperature setting on the Preferences
Window should be set to ambient room temperature.  The
experiments are based on a 1M NaCl concentration in the PCR
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reaction.

∆G = ∆H - T x ∆S
∆H is the enthalpy.
T is the temperature.
∆S is the entropy.

Secondary structures form either due to bonds at 3' end and due to
internal bonding. The 3' end blocking secondary structures reduce
efficiency more than the internal ones. Thus to take that into account,
∆G of 3' end secondary structures is decreased by 1.

Formula for Determining Single Primer Rating
Rating = 100 - (∆G (Dimer) × 1.7 + ∆G (Hairpin) × 1.4 + ∆G (False
Priming) × 1.5)

After a search for primers is completed, it is difficult to determine
which primer from the selected set will yield optimal amplification.
PRIMER PREMIER automatically rates and sorts primers based upon
the stability of the secondary structures. The rating is based on the
stability of secondary structures formed by the primers. If the
secondary structures formed by a primer are stable then it is rated low
and if they are less stable then it is rated high. PRIMER PREMIER
rates the primers based on the thermodynamic stability values of
secondary structures formed by primers. Each value is multiplied with
a specified weight, determined experimentally, for that term.  These
weights can be modified on the Preferences Window.

Formula for Determining Primer Pair Rating
Rating = Average of sense and anti-sense primer rating - ((Tm
difference between primers) * 1.7) - (DG Cross Dimer) * 1.3))

The Pair Rating is calculated from the average single primer rating of
the sense and anti-sense primer, the Tm matching between the two
primers, and the presence of any cross dimers between the sense
and anti-sense primers.
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Appendix B: Degenerate Code
This window displays the allowed degenerate bases for DNA.
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Appendix C: Amino Acid Symbols
Following are the single letter and three letter symbols for the
respective amino acids:
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Appendix D: Software Limits

Primer length 70 bp
Sequence length 50 kb
Recognition site length of restriction enzyme 19
Maximum number of cut sites shown 50
Maximum number of primer pairs searched 1000
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Appendix F: System Specifications

For Windows Operating System (Windows 98/NT 4/2000):
Required Recommended

CPU Pentium/ 100 MHz Pentium 166 MHz
RAM 32 MB 64 MB

For Power Macintosh Operating System (7.0 or later):
Required Recommended

CPU Power PC PowerPC G3
RAM 56 MB 64 MB

Service and Support
PREMIER Biosoft International is committed to providing the best
service possible. As a part of our commitment we offer free, lifetime
technical support to all PRIMER PREMIER users. Our highly rated
technical support staff offers assistance by telephone, fax, or
electronic mail.

Further Information
For more information on PRIMER PREMIER or other PREMIER
Biosoft International products call, fax, e-mail or write:

PREMIER Biosoft International
3786 Corina Way
Palo Alto, CA 94303-4504
Tel: 650-856-2703
Fax: 650-843-1250
E-Mail: support@PremierBiosoft.com
Web: www.PremierBiosoft.com
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